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Getting Familiar with the Database 

MainMenu 

 

When logging in ensure that your name is not in red when logging 
into the system.  You may not have all the correct permissions if 
Denbigh does not know who you are. 

Toolbars 

 

1 - Click to scroll record to record, 2 - Record Number (can enter a 
number to go to a record), 3 - Pie Chart depicts approximately the 
portion of total records (click to see converse result), 4 - Records 
Found out of total number of records, 5 - View all records (after 
finished with a find)  6 - Find Records in any field, 7 - Sort Records 
on any field 
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Buttons and Icons 

 

1 - Scale size of window, 2 - Zoom out, 3 Zoom in, 4 - Status 
Toolbar toggle, 5 - Mode Menu (Browse, Find, Layout and Preview). 

Community File 

 

Denbigh is based around a community file, only 1 community record 
per person.  A person may be a member of different files, Staff, 
Students Current, Former, Further and Family, which will give them 
a status. 

Family File 

 

All families are attached to students either Current, Former or 
Future. 
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Students Files - Future, Current and Former 

 

There should only be one student record either Future, Current or 
Former. 

Current Students - Related Files 

 

Student Attendance, Sport, Extra Curricular, Music, Pastoral Care, 
Reference and Textbooks are all files that relate to the current 
students. 
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Staff File 

 

Staff absence, Professional Development, Daily Bulletin, Playground 
Duty are all files that relate to the Staff File. 

Working with Records 

 

Click the pages of the teledex button to view each record, or drag 
the scroll bar. 

Moving from one file to another 

 

Click to go to a file.  Also click on the Window Menu and choose a 
file from the Show Window option. 
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Click on the Main Menu button to go back to the main menu at any time, 
to also go to another file. 

 

Quick Search 

 

Click the Quick Search button on the Main Menu to search any 
person in the database. 

 

Enter the search criteria and press the tab, enter keys or click the 
"Show Results" button. 
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List of matching data will display, grouped in type of person.  Click 
on the arrow to go to that person's record. 

 

Click the Mainmenu button at any time to back to the Mainmenu.  
The Back button will take you back to the previous layout that you 
were on.  View as list displays records in a list view. Find Student 
will to into Find for searching.  Search Assistant will display options 
for quick searches (e.g. finding all primary or secondary students). 
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Viewing records as forms or lists 

 

Click the View as List button to view the current records in list view 

View records as list 
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Click to view records in form view 

Finding Records - Quick Find 

 

Using the Quick Find feature you are able to search across any field 
on a layout without needing to enter Find mode or specify the value 
in more than one field.  This will depend on which fields have been 
set for this feature and in which layout.   This example show finding 
tutor group 12.2. 

Finding Records 

 

Click on the Find Student button to Find or use the keyboard short 
cut Command (Windows) or ⌘ (Mac) F.  All fields appear blank so 
that you can search on any fields or multiple fields. 

Mode Button 
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The mode displays on the bottom left of all screens.  To change the 
Mode button to Find.  All fields appear blank so that you can search 
on any fields or multiple fields. 

Perform Find 

 

Click the “Perform Find” or the Enter key to perform the find. To 
cancel the find click the “Cancel Find” or to view previous Finds, 
click on the Saved Finds button. 

Performing an "And" Find 
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Enter data in multiple fields.  In this example it will find all females 
in year 7. 

Performing an "Or" find 

 

Click find enter the details of the first criteria to search, then Click 
"New Request". 
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Enter the second Criteria, then click Perform Find.   

Find Result 

 

This will find all females and all year 7 students. 



 

 16 

Constraining the Found Set 

 

Click find enter the details to constrain the found set to, in this 
example we had found all females and year 7 students.  We are 
now going to just find those in this found set that are in the Blue 
House. 
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Enter the data (Blue) in the House field, go to the Requests menu 
and choose "Constrain Found Set". 
 

Find Result 

 

This has now found within the previous find, only students in the 
Blue house. 

Extend the Found Set 
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Click Find and enter the criteria.  Add year 7 in the academic field. 

 

From the requests menu choose "Extend Found Set". 

Find Results 

 

Added all students in year 7 to the previous find. 
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Omitting data in a Find 

 

In this example we have found all students in year 9, but need to 
exclude all students that are in 9.2 Roll Class.  First perform a find 
of year 9 students.   Click Find enter 9 in the Year field, then Click 
to Perform Find. 

 

Click the the Find button.  Enter 9.2 in the tutor group field and 
then click the "Omit" button.   The Omit button on the status area, 
causes the found results to be Omitted from the results rather than 
displayed, which is useful when you wish to eliminate data from 
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displaying in a list. 
 

Constrain the found Set 

 

From the Requests menu, choose Constrain Found Set. 

Find Results 

 

This finds all students in year 9 except 9.2 tutor group. 
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Find using Operators 

 

More advanced searches can be run using an Operator.  it is a 
symbol or instruction that allows you to make your find request 
specific or apply some logic to the find. 
 
Clicking on the operators box to show the menu of operators that 
can be used in the search criteria.  for example to find all students 
above year 9, you would enter ">9" (greater than 9).  To find a 
range of students from year 9 to 12 enter "9...12". 
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Find in any Field - Right mouse click 

 

In any field, use the mouse to right click in the field.  Choose either 
Find Matching records, or Constrain Found set to Find with in a Find. 

Using Shortcuts or function keys 
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Some of the functions available in the Filemaker menus also have 
shortcuts usually using the Command(⌘ Apple) key.  For example to 
Show all records hold down the ⌘ key and the letter "J". 
 

Find Student (New Versions of Denbigh 2014) 

 

Find all - hold down the shift key and click the Find Student button 
Find within in a found set - Hold down the Options/Alt key 
Find and add to the found set - Hold down the Control key 
Click the Find button or the Continue button to perform the find 
This function is available for Current, Future and Former Students. 

Search Assistant 

 

Clicking the Search Assistant button will display a popup menu with 
a choice of Search functions.  (This may vary depending on the 
school). 

Saved and Recent Finds 
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You can see your last several finds in the Recent Finds list.  Also if 
you have a complex find request that you want to use on a regular 
basis, you can name it and have it for later use. 

Finding random records with Mark Function 

 

By clicking the checkbox beside a record, then clicking the find 
marked button will find just those records. 

Find Results 

 

Found just the checked records. 
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Sort Records 

 

Most of the layouts have a sort button on the main fields within that 
layout to simply sort on those fields. 

 

Wherever that button appears click to sort.  Numeric fields are 
usually sorted lowest to highest and alpha fields a to z.   To sort in 
descending holding down the Options key (Alt key on Windows). 
 
Any fields that have the "sort icon" can be sorted on. To sort on any 
other fields or multiple fields, go to the records menu, choose Sort. 
 

 

Click on the field/s that are to be sorted. 
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Export Records 

 

There are quite a few ways to export or save records out of 
Denbigh.  One option is to find the data required and choose the 
Save/Send Records As - either Excel, PDF or a Snapshot Link.  
Choose excel to export the current data and field names to excel.  
Save as PDF will create a pdf of the layout.  Snapshot link creates a 
shortcut to this file so if you have a found set of records, this will 
create a link file that can be opened at a later time with the same 
found set. 
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The other option is to choose to export many more fields that may 
not necessarily be on the current layout.  Choose File Menu - Export 
records.  Give the file a name and then choose the file type 

 

When choosing to export records, check the Automatically open the 
file or choose to add it to an email as an attachment. 

 

This dialog box allows the user not only to choose the fields but also 
the files to export data required.  Once all fields are chosen, click 
the Export button. 
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Windows 
 

 

 

To move between multiply files or open a new window, go to 
the Window Menu. 
 
New Window will create a new window for the current file, to work 
in multiply windows at the same time. 
 
Show Window will display all files open, select a window to move to 
that file. 

 

Jump button 
 
The jump button is used to jump to the related record. 
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When used beside the student id field, will take you to that student 
in the community file.  When used on the family id will take you to 
that family in the family file.  When clicked on the classes list, will 
take you to that class in the classes file 

Paste without formatting 

 

To paste any text without including any formatting, eg Bold, Italics 
etc.  Press Command Option V on a Mac, or Control Shift V on a 
Windows computer.  Also from the Edit menu, hold down the Option 
(alt) key and you will get the Paste Text Only option.  This will paste 
any copied text without any formatting attached.  This function 
should always be used when copying any text from another 
program, eg MS Word. 

Student Movements – Enrolling, Re-enrolling, Alumni 
 
There should only ever be one student record either in Future, 
Current or Former.  If a student leaves the school they should 
remain in Former students until they return to the School, then they 
can be moved back into Current Students. 
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For all student movements, go to the Administrative Tasks on the 
Main Menu.  IMPORTANT always find the students that are moving 
first, then click to choose your requirements. 

 

Click Cancel to check if and find the correct student, Click yes to 
move students to Enrolled.   
 

Enrolling Future Students 
Firstly Find the Student or Students to be enrolled.  To move 
students from Future to Current either click the "Enroll Student" 
button in the future students file or in the Administrative Tasks on 
the main menu.   
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Click to choose the Current student or the found set of students. 

Former Students Returning 
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When a student has left the school use the Re-enrolment options.  
 


